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Chapter 1

Using This Guide
The purpose of this user guide is to provide reference material for your daily
use of the product and for your needs in Lawson training.

This user guide contains procedures on basic and advanced administration
features of the product. In addition, it provides information to help you
understand how to use each procedure for your business processes.

User Guide Conventions
This user guide uses specific text conventions, visual elements, and
terminology.

Text Conventions
Lawson user guides use the following standard text conventions.

This Represents
bold A key name or a function key name. For example, Shift

is a key name and Help (F1) is a function key name.

A value or command that you must type exactly as it
appears.

A program name or a file name.

italics A manual title or form name.

An emphasized word or phrase.

A placeholder for a user-defined value or variable.
Follow the capitalization pattern of the placeholder. For
example, �Type $LAWDIR/print/username/jobname/
stepnumber/FORMID. prt� instructs you to type the user
name, job name, step number, and form ID as follows:
$LAWDIR/print/jane/emplist/1/GL100.prt

(F1)�(F24) A function key number. �Press Help (F1)� instructs you
to press the key mapped for the (F1) function.

Key1+Key2 A key combination. �Press Shift+FndNxt (F3)� instructs
you to press and hold down the Shift key and then
press the FndNxt (F3) function key. Release both keys
to complete the action.
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This Represents
[ ] Optional parameters. You can type none, one, or more

of the parameters within the brackets. For example, the
command

qsubmit [-Un] [-jJobQueue -dDate -tTime] username
jobname

means that you can type a specific job queue, date, or
time, or you can omit these parameters.

[ | ] Optional parameters. You can type only one of the
parameters separated by a vertical line. For example,
the command

phraserpt[-n|t] BaseLanguage [Translation]

means that you can type either the n or t parameter;
you cannot type both.

... A parameter that can be repeated. For example, the
command

scrgen [-scxvV] productline [systemcode
[programcode...]]

means that you can type any number of program codes.

Visual Elements
Lawson user guides use the following visual elements.

STOP Information that must know before you attempt the procedure or
process.

Need More Details? Check out the following concepts:

� Introduces a list of topics that provide additional or background
information. Each item in the list includes a cross-reference to
the information.

Application integration. Events, required actions, or other consequences
that are related to other Lawson applications.

IMPORTANT Important information that you must consider when you perform
the procedure.

CAUTION Cautionary information about actions that involve a risk of possible
damage to equipment, data, or software.

WARNING Warning information about actions that involve a risk of personal
injury or irreversible destruction to the data or operating system.
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TIP Supplemental
information about
possible shortcuts to
the procedure or your
business process.
NOTE Supplemental
information that might
be of interest to you
as you complete the
procedure.

Terminology
The following terms have precise meanings in Lawson documentation.

Term Meaning
access Open a Lawson application form or subform.

choose Start a process.

�Choose Add� instructs you to click a button or a link on
a form to add a record to the Lawson system.

click Place the cursor over an object (such as a button, link,
or tab) and press the left mouse button.

NOTE This description applies to a standard PC mouse
with standard settings. You must translate the meaning
of �click� to what is appropriate for your equipment.

define Use a Lawson form to create a new record for a
company, a vendor, a class, a code, or another entity
used throughout the Lawson system.

� or �

Specify configuration parameters, printers, security
roles, data areas, and so on.

run Send data for processing. For example, run a report
or batch job.

select Identify an item to process. Selecting an item does not
start a process.

To select an item, place the cursor over an item and
then click.

If you use character-based mode, highlight an item to
select it. Sometimes, you must also press Mark or Next
or choose OK.

type Press keyboard keys to enter information in a field, then
move the cursor to the next field.

At a command line, type the letters exactly as written in
the procedure, then choose OK.

OK Choose OK to save or process the data that you entered
on the current form.

� �Choose OK� instructs you to click a button or a
link on a form. An �OK� button might be labeled
�Update� or show a check mark. An �OK� link might
be labeled �OK.�

� �Choose OK� instructs you to press the keyboard
key mapped as Enter.
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Lawson Documentation and Support
Lawson offers several levels of support for its products, including several types
of documentation as well as the Lawson Global Support Center help line.

� "Lawson Online Help" on page 10

� "Lawson Guides" on page 11

� "Installation Instructions and Release Notes" on page 11

� "Enhancement and Patch Documentation" on page 11

� "Lawson Global Support Center" on page 11

� "Lawson Software Documentation Contact" on page 12

Lawson Online Help
Online help is available for forms and sometimes for fields. How you access
online help depends on the desktop or user interface you are using with the
Lawson system. For more information, see the Getting Started manual for the
desktop or user interface you are using.

Accessing online
help for Lawson
Desktop

Use this procedure if you need online help
for Lawson Desktop itself, not for any of the
Environment forms you may be accessing through
it. See "To access online help for Lawson Desktop
(LID)" on page 10.

Accessing
online help for
Environment forms

Use this procedure if you need online help for
specific Environment forms. See "To access online
help for Environment forms" on page 10.

Accessing
online help for
applications from
within the Lawson
Desktop

Use this procedure if you need online help for one of
the Lawson applications and you are accessing the
application forms through the Lawson Desktop. See
"To access online help for applications from within
the Lawson Desktop" on page 11.

Accessing
online help for
applications from
the Lawson Portal

If you need online help for one of the Lawson
applications and you are accessing the application
forms through the Lawson Portal, see the
instructions in the Getting Started with Lawson
Portal User Guide.

STEPS To access online help for Lawson Desktop (LID)
1. Start a Lawson Desktop session.
2. Click Help (the button with a question mark)

� or �

Select Help Topics from the Help menu.

STEPS To access online help for Environment forms
1. From within Lawson Desktop, transfer to the Environment form you

want to work with.
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2. From within the form for which you want help, press Help (F1).

The help text for the form or for a section of the form will be displayed.

STEPS To access online help for applications from within the
Lawson Desktop
1. From within Lawson Desktop, transfer to the application form you want

to work with.
2. For field level help, position the cursor in the field for which you want help

and press Help (F1) or choose Field Help from the Help menu.
3. For form level help, select Form Help from the Help menu.

Lawson Guides
The Lawson Documentation library includes a full range of Lawson Guides
or manuals on Environment and application topics. For a complete listing
of the manuals, click on the Document Center link at the Lawson Global
Support Center web site (support.lawson.com) and then click the Product
Documentation link.

How you access Lawson documentation depends on which desktop or user
interface you are using and on how you have installed the documentation. For
instructions on how to install the documentation, click on the Document Center
link at the Lawson Global Support Center web site (support.lawson.com),
click Product Documentation, select a platform and release, and then click the
Download button or link.

Installation Instructions and Release Notes
Lawson provides installation instructions and release notes for its products.
When troubleshooting, please check the installation instructions and release
notes to be sure you have installed the software correctly and have met all
hardware and related software requirements.

Enhancement and Patch Documentation
When necessary, Lawson provides release- and platform-specific
enhancements and patches. Lawson delivers these enhancements and
patches in the form of maintenance service packs, interim cyclical patches,
service packs, and so on. The documentation for these either accompanies
them or is available through the Download Center of Lawson�s Global
Support Center web site.

Lawson Global Support Center
The Lawson Global Support Center (GSC) is available to all Lawson clients
who purchased maintenance support for their Lawson products. The GSC
help line is open Monday through Friday from 7:00 a.m. to 7:00 p.m. Central
Standard Time. Emergency service is available after 7:00 p.m. and on
weekends.
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Help Line (main number) 800-695-9000

Help Line (New York State number) 800-888-3440

Help Line (United Kingdom number) 800-695-90000

Internet Help Line http://support.lawson.com

email address gsc@lawson.com

Fax (North America) 651-767-4931

Fax (Europe) 651-767-4931

Before you contact the Lawson GSC, you must collect the following
information:

� Your client ID number

� Hardware type

� Product

� Release level

� Program number(s) in question

� The exact steps you performed prior to the problem occurring

� The specific error messages displayed on the form or report

� Any additional data such as reports, data file information, form prints,
and so on.

How the GSC Help Line Works
When you speak with a product expert, your problem is recorded in an
automated call tracking system. Lawson tracks the time of the call, when
it was accepted by the product expert, notes regarding the call, and the
time the call was completed. A call does not become completed until the
question or problem is resolved.

If you would like to place an enhancement request for a Lawson product,
please contact the Help Line with your suggestion(s). Enhancement requests
are entered into an online enhancement tracking system and are reviewed
and responded to by the appropriate Product Manager.

Lawson Software Documentation Contact
We welcome your questions or suggestions about Lawson�s documentation.
Please send comments to Lawson�s Documentation Production Manager
using the fax number or Internet mail address below.

Fax number 651-767-4931

Internet mail address documentation@lawson.com
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Documentation Contact
We welcome your questions or suggestions about Lawson documentation.
Please send comments to

documentation@lawson.com
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Chapter 2

e-Procurement Overview
This section describes the functionality and components of Lawson�s
e-Procurement product. The following sections will help you get started in
administrating this product by helping you understand what the different
components are and how they work together.

� "What Does e-Procurement Do?" on page 15

� "What Are the e-Procurement Components?" on page 16

� "How Do e-Procurement Components Work Together?" on page 18

� "What Is webMethods?" on page 19

� "What Is the webMethods Developer?" on page 20

� "What Is the Trading Networks Console?" on page 20

� "What is the Web Manager Window?" on page 20

What Does e-Procurement Do?
Lawson e-Procurement provides seamless integration and connectivity
that automates and streamlines 360° business processes while enabling
organizations to interact fully, and with maximum visibility both internally
and across the globe. Lawson e-Procurement is a product that enables
organizations to search multi-supplier, internet-based multimedia rich
catalogs, create requisitions and purchase orders, and process transactions
in real time within a fully integrated business solution environment.

Lawson e-Procurement enables users of Lawson Requisitions Self Service
to order supplies from a specific vendor�s web site. With e-Procurement, a
vendor page is linked to a shopping icon (called Punchout) on the Requisitions
Service Center home page. When the user chooses a specified vendor,
that vendor�s website catalog appears. From this catalog Requisitions Self
Service users can choose items to order. By separate agreement between the
customer and the vendor, the vendor can display the customer�s special cost
information for catalog items and can limit the catalog items that are displayed.

When users have filled their shopping carts (virtually speaking) and checked
out from the vendor web site, the chosen items and their cost are returned to
the Lawson server where a requisition is created using the Requisitions Self
Service application. A purchase order is then created from the requisition.
After the requisition is interfaced into the Lawson Purchase Order system,
e-Procurement enables the transmission of purchase order documentation
back to the vendor so that the vendor can fill the order.

Any purchase orders created from within Lawson as XML or EDI can be
sent to the vendor via the Lawson EDI application or via webMethods
integration. webMethods is a provider of integration software solutions for
rapidly automating business processes within the enterprise and with trading
partners across the Internet. They offer a comprehensive integration platform
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that forms a strong base on which to build a seamlessly integrated business
network.

e-Procurement enables organizations to manage a complex mix of internal
and external procurement information, providing connectivity to preferred
trading partners and stakeholders, and delivering accurate, up-to-date data
about the purchasing process. Our experience working with organizations
has taught us that procurement is often inefficient and complex. We know that
manual, fragmented and labor-intensive processes create a host of problems.

e-Procurement automates tasks associated the acquisition of products and
services through the following features:

� Punchout Shopping on vendor managed websites through secure
connectivity between Lawson requisitions and the systems of the trading
partners and digital marketplaces that are exposed to the Internet.

� Pre-built Connectivity B2Bi (Business-to-business integration) is
pre-built to an ever growing number of major trading partners. XML based
�connectors� are downloadable from the Lawson support site.

� Order Management The submission or receipt of Purchase Orders,
Purchase Order Acknowledgement, Advance Ship Notice, and Invoices
unrelated to Punchout.

� Web Manager a view that allows Lawson customers to track their
transactions from creation to fulfillment, providing visibility through B2Bi
tools that enable outward integration.

What Are the e-Procurement Components?
e-Procurement uses various Lawson and 3rd-party components to create the
Shopping Experience. These components include

� Lawson Requisitions, Inventory Control, Accounts Payable, and Purchase
Order server applications

You will set up these applications with basic information and processes
necessary for requisition processing, such as the currency you will
use, your accounting units and accounts, the names and locations of
your vendors, your inventory locations and items, your requesters, and
requesting locations.

Requisitions. Before you can create requisitions, you must set up the
Requisitions application, including requesters, requesting locations,
and approval codes. The Requisitions Self-Service tab on Requester
Maintenance (RQ04.1) allows you to define the tasks allowed in the
Requisitions Self-Service application. For more information, see the
Requisitions User Guide.
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Inventory Control. The Requisitions Self-Service tab on Company
(IC01.1) allows you to define the tasks allowed in the Requisitions
Self-Service application. UNSPSC Product Codes (IC16.1) and Item
Master (IC11.1) allow you to create an item hierarchy that enables user
searches at each level, based on the UNSPSC codes developed by
the United Nations in association with Dun & Bradstreet. The Search
Catalog allows you to look up items and keywords in up to 28 origin
fields determined by set up. Keywords and search criteria are defined
in the Lawson Inventory Control application. For more information, see
the Inventory Control User Guide.

Purchase Order. Purchase Order Vendors and Locations must be
defined prior to using Requisitions Self-Service or submitting orders to
Order Management Partners. Electronic Data Interchange (EDI) is
defined as your PO Vendor Issue Method if your company is issuing
purchase orders via EDI. The Punchout tab on PO Vendor Maintenance
(PO10.1) and Vendor Purchase From Location (PO10.2) allows you to
specify whether or not to allow changes to punchout items. For more
information, see the Purchase Order User Guide.

Accounts Payable. Vendors must be set up in Vendor Maintenance
(AP10.1) for processing. For more information, see the Accounts Payable
User Guide.

� Lawson Requisitions Self-Service.

The Requisitions Self-Service application lets you create requests
with demand on stock and demand on vendors, and process, view,
and modify requisitions. For more information, see the Requisitions
Self-Service User Guide

� Lawson ProcessFlow.

ProcessFlow (reqapproval1.flo and reqapproval2.flo) routes requisition
approval requests to approvers. Each flow has up to six levels of
approval, based on dollar amounts. You define approvers and dollar
amounts according to their requirements for a company/requesting
location. For more information, see the ProcessFlow User Guide and the
ProcessFlow Reference Guide.

� Lawson e-Procurement Portal.

The e-Procurement Portal is used by the e-Procurement administrator
to define users, groups, and vendors, and set up their access to
purchase orders. Bookmarks also allow the administrator to synchronize
information between Lawson and webMethods, a 3rd-party product used
in e-Procurement, and to define how purchase orders are transmitted to
the vendor. This document describes concepts and procedures related to
e-Procurement administration tasks.

� webMethods Integration Server components.

These components manage users, groups, and vendors within the
webMethods product and allow the administrator to track and troubleshoot
purchase order processing. For more information, see the documentation
provided by webMethods.

� Lawson Internet Object Services (IOS).
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Requisitions Self-Service access for use with e-Procurement is based on
Web User Profiles. The e-Procurement Portal also uses IOS to create
bookmarks. For more information, see the Lawson Administration Guide.

� A database.

The database stores e-Procurement data from webMethods. For more
information, see the documentation provided by webMethods, and
optionally a third party vendor if an external database is used.

The following diagram illustrates the e-Procurement components within the
Lawson system and related 3rd-party products.

Figure 1. e-Procurement Components
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How Do e-Procurement Components Work Together?
Punchout allows requesters to access external vendors websites, shop for
items, and return selections to a Lawson Requisition. Punchout is a vendor
managed catalog where items and prices are determined by your trading
partner relationship. Each Punchout vendor�s shopping experience is unique.

After e-Procurement has been set up, users of Requisitions Self-Service
(RSS) who click a Shopping icon will cause the shopping website of a
supported vendor to be displayed and a Lawson requisition to be created.
The user can then buy items at the web site.
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When the user is done shopping at the vendor site, e-Procurement returns
the user to RSS. The user can save their requisition as a draft or do checkout,
which causes the requisition to be released.

Orders may also be sent using e-Procurement if the vendor belongs to the
Order Management Partners. These orders are not created from Punchout or
RSS.

Purchase orders can be transmitted to the vendor after the PO is released.
Lawson�s EDI product is one method of transmitting data electronically. For
more information, see the EDI Standard User Guide or the EDI Professional
User GuideThe Punchout tab on PO Vendor Maintenance (PO10.1) and
Vendor Purchase From Location (PO10.2) allows you to specify whether or
not to allow changes to Punchout items. For more information on setting up
PO Vendors for EDI transmission of purchase orders, see the Purchase
Order User Guide.

The webMethods Server transmits purchase orders.

ProcessFlow submits a requisition for approval through the Lawson system,
as defined by the customer�s setup. Two flows (reqapproval1.flo and
reqapproval2.flo) route requisition approval requests to approvers. For more
information on the role of ProcessFlow in Requisitions Self-Service, see
�What is ProcessFlow?�, in Appendix A of the Requisitions Self-Service User
Guide. Alternatively, purchase orders can be approved manually.

What Is webMethods?
webMethods is a third-party software company providing products that
facilitate communication between businesses. e-Procurement uses four
webMethods components: two server pieces (Integration Server and Trading
Networks server) and two client pieces (webMethods Developer and Trading
Networks Console). Trading Networks server is an add-on to the Integration
Server, and after installation becomes tightly integrated with the Integration
Server. They are collectively referred to as the webMethods Server in this
documentation, unless stated otherwise.

webMethods enables different computer systems to pass information back
and forth in a manner in which each system can recognize and store the
information being received. webMethods uses document type definitions,
attributes, and processing rules to control the business transaction format and
processing. webMethods transmits business documents using a variety of
common Internet protocols, for example, HTTP, FTP, or SMTP.

In terms of e-Procurement, the Lawson customer receives information about
items selected for purchase and their cost. The vendor receives purchase
order information from the Lawson customer (by either EDI, webMethods, or
fax). webMethods passes this information to the Lawson customer in the
form of XML documents that are created from the time when the customer
invokes a call to the vendor. The format and the way in which Purchase Order
information is returned to the vendor depends on the type of document the
vendor can accept.

When a Lawson user clicks the Punchout icon on the Requisitions Self-Service
home page and then chooses a vendor, webMethods authenticates the user.
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What Is the webMethods Developer?
NOTE During
post-installation of
e-Procurement, on the
webMethodsDeveloper
you must verify that
the value for Access
Control List is equal to
Anonymous for all the
folders in the LawEPS
and LawPO packages.

The webMethods Developer is a component of the webMethods suite that
must be installed in order to use the Trading Networks Console.

What Is the Trading Networks Console?
The Trading Networks Console is a webMethods product that is installed on
the webMethods administrator�s PC. The Trading Networks Console is used
to track the documents that are passed between the customer and the vendor.
The Trading Networks Console contains vendor profiles and the document
attributes, document types, and processing rules that are used to put data
into a format that is readable by other computer systems. The Console also
reads the data stored in the database on the webMethods Server.

What is the Web Manager Window?
The Web Manager window allows webMethods administrators to access
Trading Networks Console data via the Lawson Portal for tracking or
troubleshooting purposes. This window allows the administrator to monitor
and troubleshoot documents transmission between the customer and the
vendor. The Web Manager Window can be used by the administrator to
troubleshoot errors that may have occurred during the Punchout session,
such as connection problems, or to check on the status of requests, such as
whether a vendor confirmed the receipt of a purchase order.

The Web Manager Window also provides access to webMethods
configuration tasks, such as activating custom pages or configuring Web
Manager for partners.
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What Are the e-Procurement Concepts I
Need to Understand?

What Is Punchout?
Punchout refers to the selection of items for purchase on a vendor�s web
site. When a user clicks the Punchout task on the Requisitions Self Service
home page and then selects a vendor, a dynamic HTTP link is established
between the customer and the vendor. The user can then select items to
order from the vendor�s online catalog and add them to a Lawson requisition
after checking out from the vendor�s web site.

What is Order Management?
Order Management refers to the handling of Purchase Orders, Purchase
Order Acknowledgement, Advance Ship Notice, and Invoices using
webMethods but not Punchout or RSS.

What Are Users and User Groups?
webMethods utilizes defined users and user groups to authenticate clients
and determine the server resources that a client is allowed to access. A user
contains the user name, password, and group membership. A group contains
the group name and a list of users in the group.

Lawson e-Procurement users are set up as valid requestors on the Requester
Maintenance (RQ04.1) form and the User Personal Profile and Web Name
(RD30) form.

Lawson delivers two types of groups: Punchout and Purchase Order (PO).
You will add users to the Punchout groups to enable their access to the
vendor through Requisitions Self Service. The Purchase Order groups are
used to configure a different URL or delivery protocol for transmitting the
purchase order to the vendor. The group names are preconfigured in the
Trading Networks Console.

How Are Lawson and webMethods Users and
Groups Related?
Since e-Procurement is an Internet solution, a Lawson Web User record
must exist for each Requisitions Self-Service (RSS) user. After the user
logs in to RSS, they are validated against the User Personal Profile and
Web Name (RD30) record and the requester associated with that user. If
Punchout is enabled for that requester on Requester Maintenance (RQ04.1),
e-Procurement looks up the Group and Vendor information stored onB2B
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Users (ED43). The appropriate Punchout icon is displayed on the RSS
portal page for that user.

Figure 2. Lawson and webMethods User and Group Data Relationships
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user group requester vendor
PatientCard DellPunchOut ereq1 DellTemplate
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System Data
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user dept requester
jane Post-op ereq1
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Requisition Self-Service Login
User Name = john
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Returns User = PatientCare
Returns Group = DellPunchOut
Returns Vendor = DellTemplate

In the example shown in this figure, each Lawson web user is assigned to
only one Requester Maintenance (RQ04.1) requester and one B2B Users
(ED43) group. A requester can have multiple users, and a group can have
multiple requesters. Lawson recommends that you follow these guidelines
to avoid a situation like that shown in the following figure, which results in
multiple vendor icons displaying in RSS for one user.
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Figure 3. Multiple Groups Related to One Lawson Requester
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ED43 records
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What Is a Vendor?
A vendor is who you purchase items from. Vendors are specified in the
Lawson applications system, in the e-Procurement Portal, and in webMethods.

What Are Vendor Profiles and Vendor Templates?
Vendor Profiles and Vendor Templates are delivered by Lawson for use
with e-Procurement.

Vendor Profiles
A vendor profile is a document that contains information about a vendor, such
as the corporation name, contact information and how to connect to the
vendor. The vendor profile is configured so that a Lawson customer and the
vendor can communicate using the webMethods Server.
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The vendor profile contains the customer username and password (both
supplied by the vendor) for the vendor web site. The Lawson customer
enters the customer username and password into the Corporate Tab of
the vendor profile on the Trading Networks Console. If this (along with
other setup) has been done, users who access the vendor web site can be
automatically authenticated.

webMethods users are assigned to a vendor (group) on the webMethods
Server. Each vendor on the webMethods Server has a corresponding Vendor
Profile on the Trading Networks Console that contains the vendor username
and password that is used by all the users for a given Lawson customer.

Delivered Vendor Profiles
The vendor profile is delivered by Lawson and imported into the Trading
Networks Console on the administrator�s PC. The Lawson customer uses the
Trading Networks Console to import the vendor profiles into their Trading
Networks Console.

Lawson can deliver two different types of vendor profiles: the Healthcare
Connector (HC), and the Maintenance, Repair, and Operations (MRO)
Connector.

Vendor profiles are documented in the e-Procurement Trading Partners List
document, available from support.lawson.com.

webMethods Trading Networks Vendors
Vendors are specified on the Trading Networks Console Extended Fields
tab. There are two types of fields:

� Fields defined by webMethods.

� Fields defined by the customer.

On the webMethods Vendor Profile Corporate tab, the customer enters the
username and password.

The Trading Networks administrator specifies the environment type (test or
production) on the vendor profile Extended Fields tab.

Vendor Templates
A vendor template is the record in the ED system code for a vendor web site
available for Punchout. A vendor template is defined on B2B Template
(ED45). Entries on the B2B Users (ED43) and B2B User Groups (ED41)
forms link the user and group information that is entered on the Integration
Server with the vendor information entered on Vendor Maintenance (AP10.1)
and the Requester information entered on User Personal Profile and Web
Name (RD30).
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How Are Documents Transmitted to the Vendor?
After an e-Procurement Purchase Order is created, Mass PO Issue (PO120)
moves it into a file called filename.po in the SweepDir directory specified
in Mass PO Issue (PO120) or on the Requisitions Settings page of the
e-Procurement portal. This file contains multiple purchase orders in a
POLIST. The sweep program uses the vendor group and vendor number from
this list to find the Attribute ID and the User Group name attached to this
purchase order. If there is a vendor with the same service name, the sweep
program sends the purchase order to that vendor.

What Is Integration Server Package Management?
A package is a container that is used to bundle services and related elements
from Lawson that configure the Integration Server for e-Procurement.
Packages are designed to hold all of the components of a logical unit in a B2B
solution. For example, you might group all of the services and files specific to
a particular B2B marketplace in a single package.

Lawson delivers six packages to be used by the Web Methods Server to allow
the customer to communicate with the vendor. These packages are

� LawPO.zip

� WmEDI.zip

� WMcXML.zip

� LawEps.zip

� LawEmail.zip

� EDIEprocInterface.zip

These packages contain documents that tell the server how to handle specific
events when passing information back and forth between the customer and
vendor. For example, LawPO.zip contains system information about sending
a purchase order as an XML document after a purchase order is created in
Lawson from a requisition.

You import packages to webMethods server immediately after the B2B and
Trading Networks web server are installed and configured.

What Are Document Types, Attributes, and Processing Rules?
Document types are definitions of different types of documents that you
expect to pass through your trading network as you interact with a vendor
through the e-Procurement product. The document types instruct Trading
Networks how to recognize specific types of documents.

Document attributes are definitions that identify specific pieces of information
that you want Trading Networks to extract from documents, for example, the
sender of the document or the total amount of a purchase order.
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Processing rules are definitions that specify the actions that you want Trading
Networks to perform for the document. For example, you might specify that
you want Trading Networks to deliver the document to a vendor or invoke a
B2B service to process the document.

Lawson information about document types, document attributes, and
processing rules is imported to the Trading Networks Console as wMTNExport
files.

26 Chapter 2 e-Procurement Overview e-Procurement Administration Guide



Chapter 3

Setting Up e-Procurement
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Concepts in this Chapter

What Are e-Procurement Administration Tasks?
The e-Procurement Administrator performs a variety of tasks to set up,
maintain, and troubleshoot users and vendors for the Shopping Experience.
The following figure shows the flow of administrative tasks that enable set up,
maintenance, troubleshooting, and reporting for e-Procurement.

Figure 4. e-Procurement Administrative Tasks
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Each of these tasks is explained further in the following sections:

� "What Are the ProcessFlow Setup Tasks for e-Procurement?" on page 29
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� "What Are the Server Application Setup Tasks for e-Procurement?" on
page 29

� "What Are the Portal Setup Tasks for e-Procurement?" on page 30

� "What Are the User and User Group Setup Tasks for e-Procurement?" on
page 31

� "What Are the Vendor Setup Tasks for e-Procurement?" on page 31

� "What Are the Vendor Document Transmission Setup Tasks?" on page 32

� "Starting and Stopping PO Dispatcher" on page 36

What Are the ProcessFlow Setup Tasks for e-Procurement?
The e-Procurement Administrator must setup ProcessFlow for Requisitions.
The following figure shows the flow of administrative tasks for ProcessFlow
for e-Procurement.

Figure 5. ProcessFlow Setup
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Server Applications
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Each of these tasks is explained further in the following documentation:

� ProcessFlow setup is documented in the ProcessFlow Administration
Guide.

� Bookmark setup is documented in the Lawson Administration User Guide

What Are the Server Application Setup Tasks for
e-Procurement?

The e-Procurement Administrator must consider the setup of several server
applications: Requisitions, Inventory Control, and Purchase Order.
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Figure 6. Server Application Setup Tasks
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See the following manuals for more information setting up Lawson server
applications:

� Requisitions setup is documented in the Requisitions User Guide and
the Inventory Control User Guide.

� Purchase Order setup is documented in the Purchase Order User Guide.

� Default Experience setup is documented in the Requisitions User Guide
and the Requisitions Self-Service User Guide.

What Are the Portal Setup Tasks for e-Procurement?
The e-Procurement Administrator must import e-Procurement bookmarks and
set up Lawson Web Users for e-Procurement access.

NOTE Each Web User
record as specified in
User Personal Profile
and Web Name (RD30)
should have a unique
and valid value in the
Requester field.

Figure 7. Web User Setup Tasks
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e-Procurement portal set up is described in .

30 Chapter 3 Setting Up e-Procurement e-Procurement Administration Guide



For more information on setting up web users in Lawson and configuring
Internet Object Services, see the following documents:

� Lawson Administration User Guide

� Internet Object Services Installation Guide

For more information on setting up users in webMethods, see the following
documents:

� webMethods for Trading Networks Installation and Upgrade Guide

� Integration Server Administrator�s Guide

What Are the User and User Group Setup Tasks for
e-Procurement?

The e-Procurement Administrator must setup e-Procurement Users and User
Groups. The following figure shows the flow of tasks to set up Users and
User Groups for e-Procurement.

Figure 8. e-Procurement Users and User Groups Setup Tasks
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These tasks are explained further in the following sections:

� "Setting Up Groups and Users on the Integration Server" on page 35

� "Synchronizing Lawson and webMethods Users and Groups" on page 36

For more information on setting up users in webMethods, see the following
documents:

� webMethods for Trading Networks Installation and Upgrade Guide

� Integration Server Administrator�s Guide

What Are the Vendor Setup Tasks for e-Procurement?
After setting up Lawson vendors in Vendor Maintenance (AP10.1) and PO
Vendor Maintenance (PO10.1), the e-Procurement Administrator must set up
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e-Procurement vendors. This process specifies which vendors a user can
purchase from. The flow of tasks to setup vendors for e-Procurement is
shown in the following figure.

Figure 9. e-Procurement Vendor Setup Tasks
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The customer sets up Vendor Profiles by creating a group for the vendor in
the Integration Server. Importing B2B Groups creates the vendor Group
name on the B2B User Groups (ED41) page. The Template Name for a
vendor is specified on B2B Template (ED45). The Requester is attached to
the vendor on B2B Users (ED43).

These tasks are described in the e-Procurement Trading Partner List.

What Are the Vendor Document Transmission Setup Tasks?
After an e-Procurement Purchase Order is created, Mass PO Issue (PO120)
moves it into a file called filename.po in the SweepDir directory specified
in PO120 or on the B2B Settings page of the e-Procurement portal. This
file contains multiple purchase orders in a POLIST. A sweep program, PO
Dispatcher, uses the vendor group and vendor number from this list to find
the Attribute ID and the User Group Name attached to this purchase order.
If there is a vendor with the same service name, PO Dispatcher sends the
purchase order to that vendor.
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Figure 10. Setting Up Vendor Transmission for Purchase Orders Using the Portal
Interface
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The B2B Attributes (ED53) form is used to enter an Attribute Name (which is
always the Lawson Vendor) and an Attribute Value (which is comprised of the
vendor group and Lawson vendor number, joined by a hyphen). The User
Group ID from the B2B User Groups (ED41) form is then entered on the B2B
User Group Attributes (ED47) form.

These tasks are described in "What Are the Vendor Document Transmission
Setup Tasks?" on page 32.

What Are the Web Manager Setup Tasks?
The e-Procurement Administrator can use the Web Manager feature of
webMethods to monitor and analyze (troubleshoot) e-Procurement activity.

webMethods tracks the audit trail logging information that passes back and
forth between the customer and the vendor. The audit trail information records
the way a transaction is responded to and handled by the software, rather
than the details of a specific transaction. The webMethods Server stores
this information in the database. The Trading Networks Console is used to
view the contents of the database.
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These tasks are explained further in the following sections:

� "Importing Document Types and Processing Rules" on page 43
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Procedures in this Chapter

Setting Up Groups and Users on the Integration Server
This procedure enters the names of users and user groups into the
webMethods Integration Server.

To perform this procedure you must use the serviceName delivered with the
Lawson-supplied vendor profiles for the Group name for each vendor. The
serviceName appears in the Trading Networks Vendor Profile Extended field.
Use the drop-down list to view the preconfigured Group names.

Figure 11. The Trading Networks Vendor Profile Screen Displaying the serviceName
(Group names) Pull-Down List.

For more information on delivered Group names, see the e-Procurement and
Order Management Trading Partners List. For more information on vendor
groups, see "Importing Vendor Configuration Files with the Trading Networks
Console" on page 42.

e-Procurement Administration Guide Chapter 3 Setting Up e-Procurement 35



STEPS To set up Users and User Groups
1. On the e-Procurement portal interface, click on the B2B Admin link.
2. Enter a user name and password which has administrative privileges

on the Integration Server.
NOTE You can use
the default values of
Administrator (user
name) and manage
(password).

The B2B Admin interface is opened.
3. On the Integration Server, select Security > Users and Groups.
4. Select Add and Remove Groups from the bullet list atop the Users

and Groups screen.
5. In the Create Groups box, add a group for each Punchout or Purchase

Order vendor. For example, create a group called OfficeDepotPunchout
for the vendor Office Depot.

6. Select Add and Remove Users from the bullet list at the top of the Users
and Groups screen. Users are not required for Purchase Order groups.

7. In the Create Users box, assign your punchout authorized users to
the group (vendor).
� Assign users to the Group (Punchout Vendor) they are authorized

to use.
� Do not attach users to Group names for PO vendors. Only attach

users to Group names for Punchout vendors. See "What Are Users
and User Groups?" on page 21 for more information on the different
types of groups.

8. Ensure that the same users and groups appear in B2B User Groups
(ED41).

Synchronizing Lawson and webMethods Users and Groups
After entering the users and groups as outlined in the procedures "Setting Up
Groups and Users on the Integration Server" on page 35 and , synchronize
the data shared by Lawson and webMethods.

STEPS To synchronize Lawson and webMethods Users and Groups
� On the e-Procurement portal, select Import B2B Users/Groups.

The following message appears:

Lawson ED data synchronized to webMethods

Starting and Stopping PO Dispatcher
Perform these procedures to start or stop e-Procurement transmission of
XML documents to vendors.

STEPS To start PO Dispatcher
� On the e-Procurement portal interface, select Start PO Dispatcher.

The following message appears:

Sweeper is configured for: Remote and is currently
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Running

STEPS To stop PO Dispatcher
� On the e-Procurement portal interface, select Stop PO Dispatcher.

The following message appears:

Sweeper is configured for: Remote and is currently

Not Running

e-Procurement Administration Guide Chapter 3 Setting Up e-Procurement 37



38 Chapter 3 Setting Up e-Procurement e-Procurement Administration Guide



Chapter 4

Maintaining e-Procurement
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Concepts in this Chapter

System Maintenance
The e-Procurement product requires certain maintenance tasks be performed.
Some processes, such as system backups or patch installation, must be
created by the customer. Others, such as installing additional e-Procurement
packages from Lawson, are described in this manual.

The tasks requiring use of Lawson-delivered e-Procurement components or
settings are explained further in the following sections:

� "System Maintenance" on page 40

� "Web Manager" on page 40

� "What Are the Troubleshooting Tasks for e-Procurement?" on page 41

For more information on using the general administration tasks related to
Lawson products, see the following document:

� Lawson Administration User Guide

� MicroSoft SQL Server 2000 Setup and Tools Guide

Web Manager
e-Procurement information can be tracked using the Trading Networks
Console.

The Trading Networks Console has a tracking page where you can see what
cXML and EDI documents have been sent back and forth between the
customer and the vendor. The console can also be used to check on the
status of various requests, such as the status of purchase order requests (for
instance, whether Dell confirmed the receipt of a purchase order).

NOTE RSS uses the
web user/ID value
entered on User
Personal Profile and
Web Name (RD30) to
authenticate users, but
it tracks requisitions
themselves using the
Requester field that
was also entered on
User Personal Profile
and Web Name
(RD30). (That is, the
vendor does not care
who individual users,
or shoppers are, but
Lawson applications
do.)

webMethods tracks the audit trail logging information (not details of a
transaction itself but the way a transaction is responded to and handled by the
software) that passes back and forth between the customer and the vendor.
The webMethods Server stores this information in the database; the Trading
Networks Console allows us to view the contents of the database.

For more information on vendor support with e-Procurement, see the
e-Procurement Trading Partners List.

For more information on using the Trading Networks Console, see the
following documents:

� webMethods for Trading Networks Installation and Upgrade Guide

� Integration Server Administrator�s Guide

� Trading Networks Guide
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What Are the Troubleshooting Tasks for e-Procurement?
The e-Procurement Administrator can use the webMethods log files to
troubleshoot the system.

Troubleshooting tasks are explained further in:

� "Using Log Files" on page 42

� "Verifying Vendors and Packages on the Trading Networks Console" on
page 44
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Procedures in this Chapter

Maintenance and Troubleshooting Procedures
The following procedures are documented in this section:

� "Using Log Files" on page 42

� "Importing Vendor Configuration Files with the Trading Networks
Console" on page 42

� "Importing Document Types and Processing Rules" on page 43

� "What Are the Vendor Document Transmission Setup Tasks?" on page 32

� "Verifying Vendors and Packages on the Trading Networks Console" on
page 44

Using Log Files
For troubleshooting help, a log of errors is stored in the e-Procurement log
files.

STEPS To review log files
� On the e-Procurement portal, select B2B Log Files.

A list of log files appears.

Select: To review:

View the Admin Log Administrative messages.

View the Error Log Error messages, including the date and time
stamp.

View the Full
e-Procurement
Service Log

Informational messages about system activity,
such as starting and stopping PO Dispatch, or
when files are sent to vendors.

View the
Transaction Log

Information about transactions processed by the
system.

Importing Vendor Configuration Files with the Trading
Networks Console

Vendor configurations are delivered by Lawson and imported into the Trading
Networks system. The vendor configuration information is stored in the
database.
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IMPORTANT If you reinstall a vendor that has previously been set
up, you will lose all setup information, such as the DUNS number, user
name, and password. Normally vendor configuration files are imported
at installation time. When upgrading from a previous release or installing
additional vendors, be sure to check your setup for installed vendors before
you begin this procedure.

STEPS To import vendor configuration files
1. On the Trading Networks Console, choose File > Import.
2. Import either all the vendors or just the vendor(s) your enterprise is

using, one at a time.
� Use the single arrow to import the vendors one at a time.
� Use the double arrows to import all the vendors one at once.

When a vendor is imported, it will show up linked to the enterprise profile
in the Trading Networks Overview window.

Importing Document Types and Processing Rules
Use this procedure to import document types and processing rules for
each vendor.

STEPS To import document types and processing rules for each
vendor

IMPORTANT Do not reinstall existing document types or processing rules;
only add them for new vendors that were not a part of your previous
installation. If you reinstall you will overwrite existing setup data.

1. On the Trading Networks Console, choose File > Import.

An Import Data window appears.
2. Click the Select File icon on the Import Data window.
3. Select the wMTNExports.xml file and click Open.

The Document Types and Processing Rules appear on the left side of the
Import Data window under AVAILABLE ITEMS.

4. Use the blue are icon that points to the right to import Document Types
and Processing Rules.
� Use the single arrow to import the vendors one at a time.
� Use the double arrows to import all the vendors one at once.

When a vendor is imported, it will show up linked to the company profile
on the Trading Networks Overview screen.

5. Click the Processing Rules icon at the top of the window.

e-Procurement Administration Guide Chapter 4 Maintaining e-Procurement 43



6. Verify that Default Rule is at the bottom of the list of Processing Rules. If
it is not, move it to the bottom by selecting Default Rule and clicking the
blue underlined down arrow icon.

Verifying Vendors and Packages on the Trading Networks
Console

This procedure assumes that you have already imported a preconfigured file
for each vendor, as described in "Importing Vendor Configuration Files with
the Trading Networks Console" on page 42. This procedure describes the
how to verify that the files were imported.

STEPS To verify vendors and packages on the Trading Networks
Console
1. On the Trading Networks Console, choose Document Types from the

View menu.
2. Verify that the document types are shown.
3. From the View menu, choose Processing Rules.
4. Verify that the processing rules are shown.
5. Verify that the Processing Rules are enabled.
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Appendix A

webMethods Default Values

webMethods Default Values for Users and User Groups
User Groups Description

Administrator Administrators

Replicators

Everybody

A user account that has administrator privileges. You can
use the Administrator user account to access the Server
Administrator to configure and manage the server.

Default Anonymous Used when a user does not supply a user name and
password.

Developer Developers A user that can connect to the server from the webMethods
Developer to create, modify and delete services that reside
on the server.

Replicator Replicators The servers uses this account during package replication.

Group Name Members Description

Administrator Administrators This group identifies users that have administrator privileges.
A user must have administrator privileges to configure and
manage the server.

Anonymous Default This group identifies users that have not been authenticated.

Developers Developer Identifies users that have developer privileges. A user must
have developer privileges to connect to the server from the
webMethods Developer.

Everybody Administrator

Default

Developer

Replicator

All users are a member of this group. Every new user is
automatically added to the Everybody group.

Replicator Administrator

Replicator

Identifies users that have replicator privileges. This group
gives its members the authority to perform pack replication.
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Appendix B

Reviewing User and Group Data

Reviewing User and Group Data
This appendix describes how to use the e-Procurement portal page User
Group Inquiry to review information about Users and Groups.

STEPS To view user and group data
1. On the e-Procurement portal, select B2B Users by Group.

The User Group Inquiry page appears.
2. Enter a User Group in the UserGrp field and press Inquire, or press use

the buttons at the top of the page to navigate through groups.

If users are assigned to a group, data will appear on the page. Consider
the following fields:

Field Description

UserGrp ID Display only. The Attribute ID for the e-Procurement User Group shown in the
UserGrp field. See "What Are the Vendor Document Transmission Setup Tasks?"
on page 32 for more information on the Attribute ID.

User ID Display only. The User ID specified on B2B Users (ED43) is shown for each user
assigned to the e-Procurement User Group shown in the UserGrp field. See for
more information on the User ID.

Uname Display only. The User Name specified on B2B Users (ED43) is shown for each
user assigned to the e-Procurement User Group shown in the UserGrp field. See
for more information on User Names.

Requester Display only. The Requester specified on B2B Users (ED43) and Requester
Maintenance (RQ04.1) is shown for each user assigned to the e-Procurement User
Group shown in the UserGrp field. See for more information on Requesters.

Templd Display only. The Template ID specified on B2B Template (ED45) is shown for
each user assigned to the e-Procurement User Group shown in the UserGrp field.
See "What Are Vendor Profiles and Vendor Templates?" on page 23 and "What
Are the Vendor Document Transmission Setup Tasks?" on page 32 for more
information on the Vendor Template ID.

TempN Display only. The Template Name specified on B2B Template (ED45) is shown
for each user assigned to the e-Procurement User Group shown in the UserGrp
field. See "What Are Vendor Profiles and Vendor Templates?" on page 23 and
"What Are the Vendor Document Transmission Setup Tasks?" on page 32 for more
information on the Vendor Template Name.

Client Display only. The Client specified on B2B Template (ED45) is shown for each user
assigned to the e-Procurement User Group shown in the UserGrp field.

Prdln Display only. The Product Line specified on B2B Template (ED45) is shown for
each user assigned to the e-Procurement User Group shown in the UserGrp field.

e-Procurement Administration Guide Appendix B Reviewing User and
Group Data

47



Field Description

Vendor Display only. The Vendor specified on B2B Template (ED45) is shown for each
user assigned to the e-Procurement User Group shown in the UserGrp field.

Loc Display only. The Purchase From Location specified on B2B Template (ED45) is
shown for each user assigned to the e-Procurement User Group shown in the
UserGrp field.
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